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SLIDE SHOW

The E-Z View Slide Show can be enabled by the tool bar or menu command.    It will play all the graphic 
files in a folder either continuously or just once. The    Full Screen Slide Show can be exited by clicking the
mouse or the space bar.      It has other options that are outlined below.

When checked the following buttons do:

Full Screen Show : 
Runs the slides in Full Screen Mode.

Change Background Color : 
Changes the background color of the screen during the slide show.

Continuous Show :
Runs through the current folder over and over till the screen is clicked.

Randomize Order :
Plays the all slides in the current folder in random order. When not checked E-Z View will play 

the files in the current folder from the current file till the end.

Actual Size : Fits All : Shrink Fit : Center :
 Select the way the Screen Show will display the image on screen.

Disable Screen Saver During Slide Show :
Disables the OS's screen saver if enabled while the slide show is playing.    If screen saver was 



enabled E-Z View will re-enable it after the slide show has ended.

Playing MID files during the Slide Show :
If your computer is capable of playing multimedia files then Check the ScreenShow Menu 

command Enable Sound.    To change the file select Change MID file.    You can change the file during the 
Normal Screen show by pressing the select button on the MIDI toolbar,    This will t pause the slide show 
until you have made your selection.

Pausing the ScreenShow :
Press the Pause key on the keyboard.    This will pause the current picture for 30 seconds.    hit 

any key to resume.    The spacebar will end the show.

Stoping the Screen Show : 
When in FULLSCREEN click screen or press spacebar.
In NORMAL MODE click stop button or press [ F12 ] key.

Time Bar:
Select the amount of time delay between the loading of images.

See Also
General Property Page
File Save
File Types
Slide Show 
Folder Pages





To Contact GJC Software:

GJC Software
340 Grand Central Parkway
Bayville,    New Jersey 08721-2716

(908) 269-6799

On the Web
http://members.aol.com/GJCNJ/index.html 
Email      72652,62@Compuserve.com 

Registering your copy will entitle you to a discount on future    version of E-Z View when they are 
released.    You may register at our web site for convenience.

If you purchased E-Z View at a show or store please include the serial number on the disk,.
By Mail



E-Z View

Registration Form

Name: ___________________________________________________

Address:    _________________________________________________

City: ____________________________________________________

State: _________________________ Zip: _______________________

Phone ____________________________________________________

E-Mail Address ____________________________________________

Where Purchased    __________________________________________

Your Web Page _____________________________________________

Serial Number ______________________________________________

GJC Software
340 Grand Central Parkway
Bayville,    New Jersey 08721



General Information

E-Z View is a graphic viewing program for Windows 3.1 and will also work on Windows 95. E-Z 
View does not require any of the VBRUNxxx. DLL's to work.    It lets you open and view graphic files 
without open dialog box’s.    Just set the folder you want and click the file. E-Z View also supports drag 
and drop from File Manager to the E-Z View Icon. 

It can view PCX, PNG, ICO, BMP, GIF, TIF, JPG, PCD, DXF and WMF formats.    It can also view 
text files by adding the extension in the property box. Right click file box to select what formats you wish 
to view.    You can view the image full screen by clicking the image.    By right clicking the image, (full 
screen and normal screen) you will also get you a popup menu of features available for these items.

By pressing the appropriate toolbar button, You can set a default folder,    that each time you start 
the program it will be the active one.    All toolbar buttons have tool hints.    You can also return to the 
default folder at any time.

 E-Z View also has a slide show feature which will auto view the files in the current folder,    
starting with the current file or it will play the entire folder in random order.

There are many other features so just play around and have fun.



GJC Software
340 Grand Central Parkway
Bayville, New Jersey    08721
(908) 269-6799

E-Z Viewer 97
License and Warranty

PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE.

. EZVIEWER    is the property of GJC Software Development Co. and Gary Chrzan and is 
protected by copy right law.

. YOU MAY
. use one copy of the software on a single computer;
. make one copy of the software for archival purpose;
. use the software on a network provided you have a license for each computer that can 

access the software over the network;
. YOU MAY NOT

. copy the documentation that accompanies the software;

. sublicense, rent or lease any portion of the software;

. reverse engineer, decompile, disassemble, modify, translate, make any attempt to 
discover the source code of the software or create derivative works from the software;

. Warranty
. GJC Software warrants that the media on which this Software is distributed will be free 

from defects for a period of sixty (60) days from date of delivery to you;
. GJC Software does not warrant that the Software will meet your requirements or that the 

operation of the Software will be uninterrupted or that the Software will be error free;

. In no event will GJC Software be liable for any special, consequential, indirect or similar 
damages, including any lost profits or lost data arising out of the use or inability to use the
software even if GJC Software has been advised of the possibility of such damages;

. In no case shall GJC Software Liability exceed the purchase price for the Software;

. This agreement shall be governed by the State of New Jersey;
. Updates

. GJC Software will provided a free update to the end user if purchase was made within 30 
days of release of update.

. To get the update user must be registered within 60 days of purchase.





Converting File Format

E-Z View will convert between the following formats GIF, JPG, TIF, BMP, PCX and PNG.

1. Select the file you wish to convert.
2. Select Save File As from the file menu.
3. Change the file name and extension to the format you wish.
4. Change the directory to the one you wish to save the file in.
5. Select OK.
6. If the file exists you will be prompted if you wish to overwrite the existing file.
7. If you have checked Display this screen at file saves you will now get the save properties screen.
8. Adjust the settings to your preference. (If Necessary)
9. Select Done or Cancel.
10. The file will now be saved in the proper format.

Note: Do not save a file to a floppy disk during a file conversion as the size of the file cannot be 
determined until it is saved. File size depends on compression settings and type. Save file to Hard Disk 
then copy the file to a floppy.

E-Z View will not convert files to WMF, PCD,    DXF or ICO,    these are read only formats.

E-Z View will convert PCD and most DXF to any of these GIF, JPG, TIF, BMP, PCX and PNG.



Image Resizing

To resize an image first select the image you would like to resize.    Select Resize from the Options / 
Image Options menu.    You will then get a resizing Dialog Box. In this box you can select the amount of 
size increase or decrease with the preset Radio Buttons or percent scroll box. You may also enter the 
amount of resize directly into the width box and height box. Press OK or Cancel at this point. If you 
pressed OK EZ Viewer will display the resized image on the screen. If is what you want you must save 
the file to the format and name you want. if you do not save the new image it will be lost when you select 
a new image. 

Caution must be used not to overwrite the existing file.

See Also

Zoom
Cut / Copy / Paste
Cropping



Image Cropping
To crop an image first select the image you would like to resize.    Select Cropping from the Options / 
Image Options menu. The Image will move to the upper left corner of the screen and appear in actual 
size. If the portion you want to crop is not visible then you move the scroll bars or resize the image to get 
the area you want. 
To start cropping place the cursor at the start point and press the left mouse key, keeping the key pressed
drag the mouse and a rectangle will appear . This rectangle defines the area of the crop. When you let off 
the mouse key the area of the crop will be on the screen. If is what you want you must save the file to the 
format and name you want. if you do not save the new image it will be lost when you select a new image. 

Caution must be used not to overwrite the existing file.

See Also

Zoom
Cut / Copy / Paste
Resizing



Cut Copy Paste

Images : 
Cut, Copy, and Paste images to and from the clipboard.

Example:
Shortcut keys are in red.

1 Start your word processor.
2 Start E-z view.
3 Select desired file.
4 Select the Copy command from the Edit menu.    Ctrl C
5 Select Word Processor.    Alt Tab
6 Select Paste.    Ctrl V
Done.

Text:
Only Copy works in the text viewer . Select the text you want to copy. Select Copy or Ctrl C.

See Also

Zoom
Resizing
Cropping



Zoom

To Start the zoom mode press the zoom icon on the main tool bar, Select Zoom from the Options / Image 
Options Menu or press the + or - key on the keyboard.    You can zoom in with the + key or the left mouse 
button,    you can zoom out with the - key or right mouse button. To zoom in on a particular area use the 
mouse just point and click.
To go back to normal mode press the zoom tool bar button or Shift + F4. or just select another image. 

See Also

Cut / Copy / Paste
Resizing
Cropping



Keyboard Short Cuts
F1 Help
F2 Rename File
Shift + F4 Enter or Exit Zoom Mode
F5 Refresh File List
Shift + F5 Return to folder 5
Shift + F6 Return to folder 6
Shift + F7 Return to folder 7
Shift + F8 Return to folder 8

Ctrl + Q Exit Program
Ctrl + P Display Application Properties
Ctrl + E Display EZ Image Editor
Ctrl + A Display image actual size
Ctrl + B Fit large images to viewing area
Ctrl + F Stretch and shrink all images
Ctrl + Z Zoom
Ctrl + O Screen Show Options
Ctrl + S Start Screen Show

Ctrl + C Copy
Ctrl + X Cut
Ctrl + V Paste



General Properties

Title Bar
These settings control how file information is displayed on the screen.
View File Information when checked show the information in the title bar of the image.
Filename Uppercase when checked makes all letters in the file name and path upper case.
View File name Full Screen when checked puts the file name on the top left of the full screen 

image
Normal Font Full Screen when checked is the default font. when not checked the font is 
the user selectable font from the main screen.

PCD Mode 
Controls how a pcd image is read.

Delete to recycle bin
When Selected EZ Viewer will always delete to recycle bin .(Recomended)

MIDI Auto repeat
Plays music files over and over and over.

Dither Image
Dither the Colors on low color systems

Start EZ Viewer Full Screen
Does this need an explanation.

Quick Escape



Makes the escape key a exit program button.

Auto Load Thumb Nails
When checked automaticly loads the thumb nails for the selected dir if any were previously 

created.

Display Help In Status Bar
When checked displays help in the status bar about what the mouse pointer is currently over.

See Also
General Property Page
File Save
File Types
Slide Show 
Folder Pages



File Read

File Filters
Check the box for the file type you want to view. EZ Viewer does not just view one file type at a 

time you can have multiple types, including text.

Read Resolution
Forces EZ View to read a file in a specific mode.    (Automatic is the recommended Setting)

Text File Filters
EZ Viewer will read text files of any type. It will only display human readable characters. To add a 

file type do the following
type an asterisk ( * )
type a period ( . )
type the ext.    ( txt )    any file extension you want
type a semi colon ( ; ) 
repeat

You can have up to 10 ext. at once but they must be separated by a semi colon

Important Note : It is recommended to leave the TXT box unchecked unless you are looking at TXT files. 
This will speed up the response time to start a slide show as EZ Viewer will not view text files in the slide 
show.

See Also
General Property Page
File Save



File Types
Slide Show 
Folder Pages

 



Property Dialog Box



File Save Page

Image Write Quality
The option selected here is the amount of colors (also file size) that EZ Viewer will write to a file.   

The best position is automatic as EZ Viewer will determine the proper format. The exception is JPEG 
Gray, this option creates nice b/w photo out of color ones.

JPG Save Quality
1 to 100 JPEG Photo compression the smaller number = small file lower quality

JPG Smooth
Smoothes Grainy Files.

TIF Save Compression
LZW is the best setting    none is default

Tiff Append
When Checked appends the existing file.

PNG Interlaced
Replacement for GIF

Display at file save
when checked will bring this page up at every file save. (recommended)



See Also
General Property Page
File Save
File Types
Slide Show 
Folder Pages



Default Folders

This Page is a simple one to set a directory just double click the edit box or press the edit button on the 
right side of the edit box.    When you do this you will get a chose folder dialog . Simply select the directory
you want or create a new folder right here. The M / C Folders page looks and works the same.

The Default File Save As Folder when checked will always set the File Save As dialog box to the folder 
you select. If not checked the default folder will be in the same directory as the original file.

See Also
General Property Page
File Save
File Types
Slide Show 
Folder Pages



Print Screen

Print Screen gives you the option of capturing any screen on your computer and saving it as any 
file type that EZ Viewer supports. To start print screen select from the Options Menu / Print Screen.
EZ Viewer will now minimize.
To Capture the entire screen press the Print Screen button on your keyboard.
To Capture an individual window,    select it, Press [ Alt ] Print Screen on the keyboard.
EZ Viewer will now restore itself and display the Screen Capture.    If it is what you want you can save it, 
resize it or crop it.



Set Wall Paper

EZ Viewer will automatically set the current image as windows wall paper. Just select Options / Set Wall 
Paper. To remove wall paper you must go to your system properties page and select none.



Tool Bars

    Zoom

    Copy Paste

    Instant Folders

    Instant Save

 Start Screen Show

 Print Current Image or Text File

    MIDI Start Stop Change Music Files

    File Move Copy Tool Bar



Select or Create A New Folder

To select a folder just click on the folder you want and press OK.

To create a new folder:
1. Select the root folder that you want.
2. Type \ (backslash) in the edit box.
3. Then type the name of the folder you wish to create.

Note: EZ Viewer does not allow you to delete any folders because the folder may contain other files 
besides graphic files.    To delete a folder use Win 95 explorer.



Instant Folder Access

EZ Viewer 97 allows you to set eight folders as favorites. With instant folder access you can jump to 
different folders with just a mouse click or keyboard stroke.    The first four folders are accessed by the 
four colored buttons on the toolbar. The first of these buttons is the default starting folder for EZ Viewer.    
Each time you start EZ Viewer it will default to this directory.
The second set of four can be accessed only by keyboard command, hold down the Ctrl Key and press 
F5 - F6 - F7 - F8 to get the folders.
To Set these folders go to the Folders Properties Page.



Instant Save

Press this button if you wish to save changes you made in the EZ Viewer Editor and you want to overwrite
the existing file. You will not be given any warning of overwrite. This function will still give you a Save As 
Dialog Box if you resized or cropped an image.

Note: It is best to save a file as a different name before editing it or make sure you have a backup copy of 
it.



Press this button to start the slide show.



Press this button to bring up the Print Dialog Box.



This toolbar controls the MIDI music files. Press play to start the music and stop to stop it. You can start 
and stop the playback during a slide show here. This is where you make the selection for the file you 
would like to play.



Rename a File

1. Select the file you would like to rename.
2. To rename a file, without changing format,    in EZ Viewer just press the F2 key or select Rename from

the File Menu or the Popup menu from the file list.
3. Type in the new name. It can be any name you want EZ Viewer follows Windows 95 Long File Name 

guide lines.
4. Press Enter and you will be prompted if you would like to change the name.
5. Press OK.

EZ Viewer will replace the filename in the list in the same place for your convenience, for example if you 
were renaming 50 pictures that were numbered and you did not want to lose your place. To see the list in 
order press the F5 key to refresh the list.

Note: If you Change the file ext. EZ Viewer will either not see it in the file list or give you an error message
that the file is not a valid graphic image.
Example:
Change Ducks.bmp to Ducks.gif will give an error when trying to read Ducks.gif. To convert formats use 
the File Save As method.



Delete A File

EZ Viewer will allow you to delete the selected file to the Recycle Bin by checking the box for it on the 
General Properties Page. Just press delete or select delete from the menu. You can bypass the Recycle 
Bin by pressing shift delete, or uncheck the Delete To Recycle Bin Box.



Copy / Move A File

EZ Viewer allows you the convenience of having 8 user defined preset folders to move or copy files to. 
This feature gives you the ability to save all you work or downloads to a single directory and sort it out 
later.    To use this feature follow these instructions.

1. Select the M/C Folders Page in the Program Properties Box. Skip this if you already have folders set 
up.

2. Chose or make your default folders.
3. Select the File tab on the Toolbar.
4. Select the Move button if you want to move the file. Move deletes the file from the original location 

after it copies it to the new location.
5. Select the Copy button if you just want to copy the file.
6. Press the button for the folder of your choice.
7. Done.









To Select a font deselect the display file information.
Right Click the Image Title.
Select a font from the dialog box.



Auto Contrast

Select Image Options / Edit Image from the menu.
Select the Auto Contrast Tab.
When Contrast on OK is checked EZ Viewer will automatically adjust the contrast of the image.    You may
use the mouse to draw a rectangle for an area to apply the contrast to. To set the contrast manually see 
the Enhance Tab.



Bleed

Select Image Options / Edit Image from the menu.
Select the Bleed Tab.
Bleeds the images colors together. The output you get will depend on the value you use and the colors of 
the image. This is one that can produce some nice effects with a little time.



Border

Select Image Options / Edit Image from the menu.
Select the Border Tab.
The Border Effect automatically puts a solid border around the image.    This effect has 14 shapes to use 
including Rectangle,    Square,    Ellipse,    Circle,    Triangles, Star, Diamond and Polygon. To change the 
color of the border deselect Form Color.

1. Select the desired shape.
2. Select the desired width of the edge.
3. Select the Color of the edge. (Mask Color) 
4. Make sure that Border on OK is checked or the effect will not be put on your image.

 

Also See

Border Fade



Border Fade

Select Image Options / Edit Image from the menu.
Select the Border Fade Tab.
This effect produces a fade from a solid color to the picture getting more transparent.

1. Select the Color of the edge. (Mask Color)
2. Select the width of the edge. 
3. Make sure that Border on OK is checked or the effect will not be put on your image.

 

This effect was achieved by using polygon setting in borders and a colored fade in border fade.



Blur

Select Image Options / Edit Image from the menu.
Select the Blur Tab.
This effect Blurs the image. A setting of 1- 5 should produce a good result.



Bright / Dark

Select Image Options / Edit Image from the menu.
Select the Bright/Dark Tab.
A positive value brightens the image and a negative value darkens the image.    The preview is 
progressive if you brighten an image with a value of 10 then preview it again at 10 it actually is 
somewhere around 30. We suggest that you undo before you apply the preview again so you can have 
an accurate value. You can also set brightness on the enhance tab.



Color Reduction

Select Image Options / Edit Image from the menu.
Select the Color Tab.
Use the slide bar to lower the number of colors in an image, value = 0 to 255. You may also select the 
type of dithering you would like to use.



Curl Page

Select Image Options / Edit Image from the menu.
Select the Curl Tab.

This tab produces some very nice curled page effects.
Keep Image when checked leaves the image under the effect.
Shade when checked shades the inside of the curl.
B Color is the background color.
F Color is the Foreground color.
Orient is where the tip of the curl starts.
Location is the direction the curl takes.
Be sure Curl on OK is checked or the effect will not take.
Also remember to undo any un desired effects.



Edge Detection

Select Image Options / Edit Image from the menu.
Select the Edge Detection Tab.
This produces an outline effect of the image.    The outcome depends on the value and the image itself.    



Engrave

Select Image Options / Edit Image from the menu.
Select the Engrave Tab.
Produces an engraved in stone or metal effect.    The results can vary depending on the image and the 
value used.



Enhance Tab

Select Image Options / Edit Image from the menu.
Select the Enhance Tab.
With individual Red, Green and Blue Gamma Controls. Along with Brightness and Contrast you should be
able to correct an image color problem.    You should save the original an work on a copy to avoid making 
any mistakes.    You can select a area to correct or you can use the whole image.



Gamma Tab

Select Image Options / Edit Image from the menu.
Select the Gamma Tab.
Adjusts the Red, Green and Blue Levels Evenly.



Gray Area

Select Image Options / Edit Image from the menu.
Select the Grey Area Tab.
Select Gray On OK
Select an Area
Press Preview



Half Tone

Select Image Options / Edit Image from the menu.
Select the Half Tone Tab.
Produces patterns in the image depending on shape, angle and cell size. Can also be set to produce a 
Gray scale image. Be sure Halftone on OK is checked.



Invert 

Select Image Options / Edit Image from the menu.
Select the Invert Tab
Invert Image produced a negative of the image.



Jiggle 

Select Image Options / Edit Image from the menu.
Select the Jiggle Tab.
Produces a jiggle line effect in the image. The effect generated depends on the image, value, Amp and 
shape settings.    You can just select an area of the image to jiggle if you like.



Mirror

Select Image Options / Edit Image from the menu.
Select the Mirror Tab.
Flips the image on its horizontal or vertical axis.



Mosaic

Select Image Options / Edit Image from the menu.
Select the Mosaic Tab.
This produces a Mosaic tile effect. similar to the old style bath floors. The possibilities are too numerous 
to list here.

 



Motion Effect

Select Image Options / Edit Image from the menu.
Select the Motion Tab.
Motion produces a variety of motion effect as motion zoom, motion rotate and motion line. The effect 
results depend on value, angel and type of motion.

 



Noise

Select Image Options / Edit Image from the menu.
Select the Noisy Tab.
Use the Add Noise filter to create a granular effect that adds texture to a flat or overly blended picture.

To add more texture to pictures or defined areas:

1. Check the box next to preview.
2. Choose a method to specify the amount of texture you want.

Uniform or 0 for an overall grainy appearance.
Gaussian or 1 for a heavier, larger grain size for the texture. 

3. Click the slide control to specify the Noise Level percentage in the color you want. 
4. Choose Preview to see the effect.



Oil Paint

Select Image Options / Edit Image from the menu.
Select the Oil Paint Tab.
Produces an oil painted effect of the image.

 



Pinch Hole

Select Image Options / Edit Image from the menu.
Select the Pinch Hole Tab.
1 Select image or area for effect.
2 Set Value.
3. Press preview to see effect.



Pixel Fix

Select Image Options / Edit Image from the menu.
Select the Pixel Fix Tab.
Fills in missing pixels.

Value = Number of neighboring pixels to exam.

1 Set Value.
2 Press Preview.



Pyramid Extrude

Select Image Options / Edit Image from the menu.
Select the Pyramid Extrude Tab.
1 Set Value for size of Pyramid
2 Check Pyramid On OK.
3 Press preview to see effect.



Rotate

Select Image Options / Edit Image from the menu.
Select the Rotate Tab.
Rotates an image at any angle.    You can do multiple rotates at the same angle with different back colors 
to get a nice effect. This can also be used to set a image that was captured wrong to the right plane.

 



Sharp

Select Image Options / Edit Image from the menu.
Select the Sharp Tab.
Sharpens an image that is too smooth.



Tile Maker

Select Image Options / Edit Image from the menu.
Select the Tile tab.
Use this in connection with EZ Viewers Wall Paper option. Produces an image that can be tiled as a 
background. I E Web pages.

 



Whirl Pool

Select Image Options / Edit Image from the menu.
Select the Whirl Pool tab.
Create a whirl pool effect on the whole image or just an area.

1 Select image or are to have effect.
2 Set value.
3 Press preview to see effect.

 



Wave Image

Select Image Options / Edit Image from the menu.
Select the Wave tab.
This produces a pond type reflection of the image.

1 Select Image or area of image to get the effect.
2 Set Phase.
3 Set Wave Length.
4 Set Amplitude.
5 Chose Reflection, Smear or both.
6 Press preview to see effect.

 




